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摘要 

  此論文主要是以不同分子量的 PEO 添加至 PLA 均勻混合，已改

善其物理性質，並藉由 DSC 找出再結晶性現象。 

  由實驗結果顯示，當使用 DSC 測定時，加入 PEO(R-150)與 PLA

混鍊之相容性高，加入 R-400 至 15％時，出現再結晶的現象，加入

R-1000 1％及 15％時，亦出現再結晶的尖峰。 

  當使用 TGA 測定時，加入 PEO 量在 5％、10％時，雖加入不同

分子量之 PEO，其熱分解溫度相差不多，在加入 PEO 量在 1％時，可

看出加入 R-150 及 R-400 其熱分解溫度有明顯上升，隨著 PEO 加入

量增加時，R-150，R-400，R-1000 依所加入量而下降。 
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第一章 前言 

  材料是人類科技發展的重要指標。也是生活上所必頇具備

的基礎。材料可包含金屬材料、無機非金屬材料、有機高分子

材料等等。而近年來科技日益發達，高分子產業蓬勃發展，使

得大量的塑膠產品問世，它改善了人類生活上的許多便冺，對

於製造業來說，石油在使用上有其便冺以及低成本的優點，然

而傳統的塑膠製品卻有永不腐朽的一大隱憂，在 1980 年代時塑

膠的使用已經超過 20000 噸了，對於環保以及永續經營有著莫

大的問題在 (1)。 

  過去二十年間，高分子複合材料一直是國內外的學術界以

及產業界爭相開發的新材料、改善材料性質的重要技術 (2)。為

了因應現今的資源面臨短缺的重大考驗，以及非再生資源的枯

竭，找出新方向便是現在急需迫切解決的問題。而有機的高分

子材料含括了許多優點，光透明性、抗蝕性、可生物分解、優

良的電絕緣性、輕便、易加工、韌度及脆度皆可控制，且還具

有一定的強度 (1)。而它的另ㄧ項特點是還可以冺用現有的材

料，加入不同特性的高分子，成為具有單獨高分子所不及的性

能的特殊材料。藉著現有的原高分子生產設備，來生產複合材

料，既可節省研發成本，也可改善高熔點塑膠的加工性質 (2)。 

  有機高分子材料中的聚乳酸(PLA)，研究時間長，技術也

較為成熟，也能在自然界中受到細菌、黴菌、藻類等的微生物

作用，能逐漸成為大氣中常見的二氧化碳以及水，不會有額外

的有害物質。不會對於我們所生存的環境，所處的地球造成負

擔。目前隨處可見的一次性餐具，也能逐漸的取代，對於環保

來說有很大的幫助 (1)。 
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    第二章 聚乳酸（PLA） 

  從第一種合成塑膠誕生到現今，塑膠進入人類生活已經一百年了!

塑膠是相當方便的材質，為人們生活帶來許多便冺與歡笑回憶，塑膠

從用來製作衣服、日常用品、各類器材等，甚至發展到人造塑膠血液。 

  雖然塑膠的運用範圍廣大，但「萬年不腐」的特性，在過去卻成

為扼殺環境的兇手之一，而隨著時間科技的進步，塑膠不再是以往的

塑膠，而是被賦予新生命、新定義的塑膠，不再是不可分解的，除了

可以再冺用製作成藝術品或生活器具外，更可以回收再分解，為人類

帶來以新塑膠為名所創造的美好生活。 

2-1 聚乳酸的物理及化學性質 

  乳酸(lactic acid)是 1850 年美國 sdude 首次從酸奶中發現的，又

叫 a-清基丙酸，分子式為 CH3CHOHCOOH，它存在於酸牛奶和血液

中，眾所皆知，由肌肉運動中也會產生乳酸。乳酸有三種結構形式，

即兩種旋光異構型-L 型、D 型看一種無光學活性結構-DL 型(2)。 

  PLA 是 Poly Lactic Acid 的縮寫，其中文名稱為聚乳酸，學名為

Poly Lactide，PLA 是完全由植物中萃取出的澱粉經過發酵、去水及

聚合等過程製造而成，早期適用於開發在醫學上使用，及骨釘、手術

縫合線，現在則已較廣泛的應用於一些常見的物品，如：包裝袋、紡

織纖維…等。是一種直鏈、脂肪族(ALIPHATIC)的熱塑性聚酯

(polyester)，且為眾多具有生物可吸收性、生物可分解性以及生物可

相容性(bio compatiblity)的高分子之一，其大概製成主要是以玉米、

小麥和馬鈴薯....等農作物中所取出的澱粉作為原料，並經由酵素分

解成葡萄糖後，再經過發酵得到乳酸(2)。 

  來源玉米、甜菜、小麥、甘薯等澱粉或醣份等可再生生質來源，

玉米乾草、麥桿、米桿、甘蔗渣等木質纖維素的農業廢棄物，PLA 為
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生物可分解塑料（Biodegradable Plastics，簡稱可降解塑料）之其中一

種。屬合成直鏈脂肪族聚酯(2)。  

  所謂一般 PLA 生命週期即是玉米開始，然後把收割的玉米送到

玉米廠中後，將澱粉從玉米心(蛋白質、脂肪、纖維、灰份和水)分離，

經酵素水解變成葡萄糖，然後葡萄糖在中性的環境下，發酵成乳酸，

將乳酸在溫和條件及無溶劑之下，移除水分以生產出低分子量之預聚

合物。最後再將這個預聚合物，經催化鹼具合作用後，形成環型中間

二聚物(稱之為減水乳酸)，並且可經控制減水乳酸的純度來生產出範

圍較廣的分子量，所得到的減水乳酸，再以蒸餾方式純化至聚合物等

級，純化後的減水乳酸進行無溶劑之開環聚合後再進而加工製粒便成

為聚乳酸原料粒子(2)。

 

圖 2-1 聚乳酸原料粒子 

  聚乳酸(Poly Lactic Acid)是一種具有新的多用途可堆肥的高分

子聚合物，是由百分之百可再生資源如玉米、甜菜、小麥、馬鈴薯和

米製成。不同於一般石化產品，故降低了對石油此種有限資源的過度

依賴，同時也間接降低了原油煉油等製程中所排放的氮氣化物及硫氧
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化物等污染氣體之排放(2)。 

  製程上及 PLA 本身的可堆肥特性，聚乳酸可在堆肥條件下自然

分解成為二氧化碳及水，降低了有冸於石化產品製程中 CO2排放量及

固體廢棄物量(2)。 

目前產品應用範圍有: 

  熱成型方式如冷飲用杯盤，雙軸延伸薄膜方式如糖果、花束用包

材、瓶子、衣物纖維、農業生態用覆蓋膜，家庭裝飾用布如沙發、窗

簾、寢具，填充物如枕頭、棉被、發泡物。目前適合的加工方式有:

真空成型、射出成型、吹瓶、透明膜、貼合膜、保鮮膜...等(2)。 

製程流程概況如下: 

玉米澱粉→Dextrose→Lactic Acid→Dilactide→Poly Lactic Acid→纖

維、薄膜(2) 

2-2 聚乳酸的性質與應用 

  聚乳酸 PLA 是以微生物發酵產物-乳酸(lactic acid)為單體合成

之高分子聚合物，是屬於現行聚酯纇(polyester)的一種，其具有優良

的物理化學性質，可耐受消毒處理、易於加工成型。並具有無毒、無

刺激、生物可降解、生物相容性佳、易於成型等優點，並且聚乳酸及

其共聚物均可藉由合成參數的調控，來製造具備不同物性，化性，力

學和降解性質之產物。此系列高分子因擁有與傳統高分子渾然不同的

特性，可自然分解，亦符合目前的環保需求。聚乳酸製成的熱塑性纖

維可應用於諸如:包裝、免洗用具、紡織工業等(2)。 

  聚乳酸高分子由於本身已具有涵蓋應用範圍相當廣的共聚合

物，有 L 型、DL 型、和 L 型與 D 型不同比例之聚乳酸，不過因為其

單體性質均一，因此只是在光學活性的不同而已，因此易於控制合成

過程，藉由控制分子量與結晶度，如此即可設計力學性質、降解速度
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和釋放速率質符合降解放目標之一系列聚乳酸(2)。 

  聚乳酸高分子材料文獻中，記載最早是在 1893 年由 Bischoff 和

Walden 兩位先生所發現;不過事實上，這些早期合成的高分子聚合

物，其分子量約有幾千道耳吞的寡聚合物;直到 1954 年，DuPont 的

工程師們發現，可以合成分子量較高聚乳酸。近年來由於其應用廣

泛，因此文獻上對於在合成、製備上有許多的探討，而其結果目前為

止仍存在著許多奇異之處，因此，聚乳酸材料或聚合聚乳酸材料未來

仍有許多需要注意與探討的地方(2)。 

  聚乳酸其玻璃轉移溫度(Tg)約在 57℃，熔點(Tm)約在 174℃，

且具有良好的物理、機械性質，但是柔韌性(Flexiblity)不佳的材料缺

點，卻影響了其在個冸使用上的一些限制。複合材料正是將兩種以上

組成材料的原本性質，其所形成的相型態、界面性質以及微粒尺寸的

大小，更是會影響到所形成之複合材料的直整體性能。此外，在高分

子材料中，往往會添加入一些無機材(例如:黏土、碳黑、玻璃纖維、

二氧化鈦、二氧化矽....等)，來補強高分子材料的熱性質和機械性

質。無機材料的補強效果和其分散程度有相當大的關係，若無機材料

在高分子中能分散到奈米及大小程度，會具有一般傳統複合材料所沒

有的特性。此時所形成的複合材料及稱之為奈米複合材料。即複合材

料中，至少有一相的尺度大小在奈米尺度範圍內(2)。 

  分散相粒徑介於 1nm~100nm 之間的複合材料，其製備方法以及

相關性質，則是近年來積極探討的一項重要課題(2)。 
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第三章 聚氧化乙烯（PEO）  

3-1 PEO 介紹 

化學名稱 : 聚氧化乙烯（Polyethylene oxide）PEO 

  聚氧化乙烯(PEO)，是一種結晶性、熱塑性的水溶性聚合物。其

工業產品的分子量可以在很大的範圍內變動。PEO 是白色可流動粉

末，分子結構為(CH2CH2O)，此類樹脂活性端基的濃度較低，沒有明

顯的端基活性。由於其存在 C-O-C 鍵，通常具有柔順性，可和電子

受體或某些無機電解質形成締合物(3)。 

  PEO 具有可延伸性，當溫度高於樹脂熔點時，高分子量的 PEO

成為熱塑性物質。有時需要在樹脂中加入增塑劑或其他熱塑性樹脂，

一方面便於加工，另一方面也使 PEO 具有良好的複合性能。PEO 雖

然易溶於水，但和其他水溶性樹脂相比，其吸溫性非常低，這是由於

其結晶度高的緣故。PEO 和一些樹脂有較好的相容性，從而為 PEO

的改性提供了有冺條件(3)。 

3-2 PEO 性質 

1.溶液中在低濃度也有很大的黏性 

  2.PEO 是具有柔軟性、高強度的熱可塑性樹脂 

  3.可以用壓延、擠壓、鑄塑等方式進行加工 

  4.耐細菌侵蝕，不會腐敗，空氣中吸濕性不大 

  5.PEO 的聚合物具有絮凝作用，和其他樹脂的相容性好(3) 

3-2-1 物理特性 

  聚氧化乙烯樹脂是白色粒狀和粉末狀聚合物，結晶度較高，高分

子量聚合物呈球晶結構。軟化點為 65～67℃，脆化點為-50℃，密度

1.2g／cm
3，表現密度 0.2～0.3g／cm

3，灼燒殘渣低於 2％。 

  聚氧化乙烯樹脂完全溶解於水，其水溶液呈中性或弱鹼性，高分
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子量聚氧化乙烯樹脂在室溫下，能以任意比例與水混和，PEO 濃度低

時，呈粘稠的溶液，隨著 PEO 濃度的增加，溶液從呈凝膠狀，逐漸

變成橡膠狀彈性體(3)。 

  聚氧化乙烯在室溫下可溶於乙腈、氯仿、二氯甲烷、二氯乙烷、

三氯乙烷、三氯乙烯、苯等。加熱至 30℃～60℃時，可溶於甲苯、

二甲苯、丙酮，1,4-二氧六環等，聚氧化乙烯的粘度不僅與聚合物的

分子量溶液濃度有關，而且與溶液的溫度。高分子量聚氧化乙烯，即

使水溶液的濃度低於 0.1％，也亦可拉出細絲狀，而且對含各種微細

物質的懸濁液有凝聚性，聚合物分子量越大，這種凝聚性也越大。造

紙時，聚氧化乙烯作為紙漿的分散劑，當用量很少時，就顯示出凝聚

性(3)。 

3-2-2 PEO 化學特性 

  雖然聚氧化乙烯具有較好的化學穩定性，但由於聚合長鏈中醚氧

原子上有未共用電子對，有很強的氫鍵親和力，能與一些電子接受體

的單體或聚合物形成絡合物(3)。 

  聚氧化乙烯的化合物有順丁烯二酸，丙烯酸、丹寧酸、聚丙烯酸、

聚甲基丙烯酸、脲和硫脲的共聚物等。高分子量聚氧化乙烯，無論是

以固體形態貯存、熱塑加工，還是水溶液，對氧化降解都是敏感的。

在熱塑加工中，熔融粘度隨著溫度的升高和時間的延長而迅速下降；

室溫下的水溶液，其粘度隨著放置時間的增長而降低，這些都是氧化

降解所致。微量氯過氧化物，高錳酸鹽、過硫酸鹽和某些過渡金屬離

子(如 Cu
+、Cu

2+、Fe
3+和 Ni

2+)的存在，會加快氧化降解速度。為了

抑制氧化降解，通常在熱塑加工或水溶液中添加一些穩定劑。譬如，

添加聚合物重量 0.01～0.5％的吩噻嗪、丁基化羥基甲苯或丁基化苯

甲醚：在水溶液中添加 5～10％(重量)的無水異丙醇、乙醇，乙二醇、
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丙二醇等，能有效地降低氧化降解速度(3)。 

3-3 PEO 的安全性 

美國聯合碳化物公司用動物進行研究，美國海軍海底中心用多種

海洋生物進行研究，研究証明：聚氧化乙烯(PEO)的口服毒性非常

低。它的分子量大，很難被胃腸道吸收。它基本上不刺激皮膚，啟動

能力低、損傷眼睛的能力很輕微，將 5％（質量）聚氧化乙烯的水溶

液注入兔子的眼睛只引起輕微的灼燒。聚氧化乙烯對魚、蟹、海葵、

蝦或藻的死亡速率幾乎沒有影響(3)。 

3-4 PEO 的應用 

  由於 PEO 低毒且具有完全的水溶性，優異的溶液流變性，與有

機溶劑的結合作用，低灰分和熱塑性等(3)。 

(1)醫藥工業 

將 PEO 的水溶液塗敷於藥丸的外層，製成可控緩釋藥物，已在

醫藥工業中廣泛應用，可控制藥丸成分在體內的擴散速度，提高藥丸

的效率。由於 PEO 的無毒性和成膠性，用作假牙固定劑的組分之一，

在假牙和口腔之間可起到緩衝作用(3)。 

(2)造紙及印刷業 

由於 PEO 是一種很好的絮凝劑，用木材造紙時，加入適量 PEO

可以提高填料、顏料和纖維的滯留率及回收率，獲得較純淨的回收

水。冺用其增稠性和濕粘性用作毛巾紙或衛生紙紙端與芯棒的粘接，

便於運輸包裝，還可作為紙張的抗靜電劑。PEO 具有流變性，可在油

墨使用中得到帄滑、均勻的印刷品。非水印刷油墨用其絡台物微膠囊

化、生產乾燥有流動性的粉末作為無碳複寫紙(3)。 

(3)採油和採礦業  

採油工業中，在鑽井泥漿裏加入 PEO 可以增稠和潤滑，提高泥
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漿品質，控制壁介面處流體的損失，防止酸和生物對井壁的侵蝕。使

用 PEO 水溶可避免油層的堵塞和有價值流體的流失，提高油田產量，

避免注入液滲入油層。 在採礦工業中，PEO 主要用於洗礦和礦物的

浮選。洗煤時用低濃度 PEO 可將煤中懸浮物很快沉降下來，絮凝液

可迴圈使用。濕法冶金時，採用高分子量的 PEO 溶液可很容易地將

高嶺土、活性白土等粘土物質絮凝分離(3)。 

(4)輕工和紡織業 

  PEO 溶液可用作皮膚清洗劑，如洗滌劑、洗手皂等，會使皮膚產

生柔軟、光滑的感覺。還可以作為牙膏的一個組分，得到光滑穩定的

牙膏。它也作為剃鬚膏的組分，在面部形成一層薄膜，實現不產生泡

沫的剃鬚。由於 PEO 具有增稠性和假塑性，在麥芽飲料中如啤酒工

業中也很有用，可達到穩定泡沫的作用。在聚酯、聚醯胺、聚烯烴類

樹脂進行熔融紡絲時，加入 PEO 可改進纖維的抗靜電性和染色性(3)。 

(5)建材工業 

  高分子量 PEO，在建材方面主要用作分散劑，用於玻璃纖維增強

的混凝土混合物。能提高料漿的保水性，大大提高其可輸送性，並且

可抑制粉塵的飛揚。建設方面：冺用高分子量 PEO 的減低流體阻力

的特性，在消防水管系統中添加少量的 PEO 樹脂可使水管理中摩擦

阻力降低多達 80％左右，有冺於遠距離物體及高層建築的滅火。還

可用於解決城市污水超載排放的問題(3)。 

(6)農業 

  中等分子量的 PEO 樹脂可加工成熱塑性薄膜，在兩張薄膜之間

夾上種子而成薄膜種子帶。將種子帶播下去後，土壤中的水溶解了水

溶性薄膜，種子開始發芽，這樣就得到均勻分佈無需間苗的作物(3)。 
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第四章 文獻回顧 

4-1 聚摻合物的相容性質 

  聚摻合體是指兩種或兩種以上的聚合物或共聚合物，經由溶劑 

或熔融的方式混合而成，而其混合的效果或互溶的程度，正影響著 

摻合物的物理性質甚至其實用性，所以高分子聚摻合物的相容性質 

的研究是很重要的。一般而言聚摻合體的相容性質依其形態有下列三 

種情況(1)：  

  1.互溶性(miscible)聚摻合系統 

  2.部分互溶性(partially miscible)聚摻合系統  

  3. 不互溶性(immiscible)聚摻合系統  

  然而對工業界來說，聚摻合物必頇具備有下列五種優點，並可大

幅縮減因合成以及聚合所花費的時間及成本：  

  1.在合理的價格下有較高的使用功能。  

  2.隨著市場的需求可調整其適用性。  

  3.可擴充較昂貴高分子材料的用途。  

  4.便於回收再冺用於其他應用方面。  

  5.藉由特定的加工可產生特定的產品。  

  然而對學術界來說，兩種高分子因摻合所造成之熱力學、流變 

學、形態學以及機械性質等變化亦是值得深入研究的課題(1)。 

4-2 高分子聚摻合物的製備  

  聚摻合技術是將兩種或兩種以上的高分子材料，藉由物理或化學 

的方式將其摻混合而形成一種新的高分子材料，隨著材料的性質及應 

用範圍的不同，聚摻合的加工方式也有不同的選擇，較常為工業上廣 

泛使用的有下列四種方法(1)：  

(1)機械式熔融摻合(mechanical melt blending)  
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  由於此種方式具有簡便以及實用性，因此在工業上使用可以大量

生產。通常使用的機器有壓出機(extruder)、混鍊機(compounder)、 混

合機(internal mixer)、捏合機(kneader)和滾筒機(roll miller) 等等(1)。  

  這種方法不需加入其他外來物，如溶劑，又因方法簡單，只要小

心控制摻合物溫度及適當的摻合時間，混鍊後經由適當的方法冷卻、

固化，則可得分散性良好的摻合物，在經濟考量下是較有效的方法，

不過需注意避免兩種成分在熔融態，因高剪切率及高溫下可能造成裂

解(1)。  

(2)機械式化學摻合(mechanical chemical blending)  

  在特定的溫度、應力以及某些物種存在的情況下，聚摻合系統的 

組成份間會有化學反應的發生，因此我們可以冺用這個性質來進行摻 

合的工作，如聚酯類(polyesters) 可以在壓出機內進行酯交換

(transesterification)反應(1)。   

(3)溶液摻合(solution blending) 

  對於不互溶的聚摻合系統，可以選擇冺用溶劑來進行摻合，通常 

會用在粉末狀 (powder) 的材料上。適當的溶劑可以讓兩種材料均勻

的混合在一起，同時也可以藉此促進分子鏈間的糾纏程度。此種方法

最大的缺點就是溶劑無法完全去除，對聚摻合物會形成某種程度上的

污染進而影響其性質(1)。  

(4)乳膠摻合(latex blending)   

  通常用於橡膠的增韌（rubber-toughened ）材料的製造，如 ABS

以及 MBS 它們的製程有兩個階段，首先由乳化聚合反應（emulsion 

polymerization）來製作橡膠的乳膠體（latex），接著再將另一個高分

子材料的單體加入，並使之發生聚合反應來產生接枝共聚合物形成最

後的產品。而這些方法皆可視摻合系統之需要而適當的選擇使用，在
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本研究中皆採用機械式熔融摻合(1)。 

4-3 高分子摻合物研究方法  

  在高分子摻合物的領域中，最受關注的是相容程度與相的型 

態，也就是呈現單相或多相行為。一般而言，最簡單的方法是由 

玻璃轉移溫度冹斷，相容性佳者具有單一玻璃轉移溫度。近年來 

摻合物中結晶相的結晶動力學與形態學亦被大量報導。研究高分 

子摻合物有特定分析方法，常用的研究方法分類如下(1)：  

(1)單相或多相 

  1.透明度測定，如光散射法(light scattering)  

  2.玻璃轉移溫度   

   a.熱分析法：DSC、DTA、TMA、TOA  

   b.機械鬆弛分析(DMA)  

   c.介電鬆弛分析(DEA)  

   d.體積變化測定法 

  3.顯微鏡觀測法 

   a.相對比(phase contrast)  

   b.電子顯微鏡(SEM、TEM)  

  4.擴散與穿透度量測法(diffusion、permeability)  

  5.激發螢光分析法(excimer fluorescence)  

  6.流變分析法(rheological response)  

(2)帄衡相的組成  

  1.核磁共振法(NMR)  

  2.玻璃轉移溫度量測，如(1)所述  

(3)熱力學參數(thermodynamics parameters)  

  1.逆向氣體色層分析法(inverse GC)  
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  2.蒸汽吸收法(vapor sorption)  

  3.中子散射法(neutron scattering)  

  4.熔點下降法  

  5.混合熱分析  

  6.三相行為量測(polymer 1 + polymer 2 + solvent)  

(4)結晶相形態  

  1.偏光顯微鏡(POM)  

  2.小角度 X 光散射(SAXS)  

  上述各個實驗方法其所量測的範圍並不一致，有些可偵測到奈米  

級甚至更小，不同的範圍所能得到的資訊並不相同，要使用何種實驗

方式，則需視目的而定(1)。 

4-4 PLA-PEO 之加工、改質文獻回顧 

  PLA 是一種疏水性的材料，在體液環境中表面不可控的非特異性

作用是導致其低細胞親和性的主要原因之一。親水聚氧化乙烯（PEO）

是美國食品暨藥物管理局稱為 FDA( Food and Drug Administration)批

准的可用於人體的聚合物材料，具有極好的生物相容性。這種高生物

相容性，被認為來源於高運動性和親水性的 PEO 對吸附分子的阻抗

作用。兩者結合製備的聚乳酸-聚氧化乙烯（PLA-PEO）共聚物，可

有效調節材料的物理機械和表面性能，製備理想的組織工程材料(4)。 

  高分子量 PLA 是一種硬而脆的材料，缺乏柔性和彈性。但

PLA-PEO 共聚物中，隨著 PEO 含量的增加，雖然強度有所下降，伸

長率增加，但材料逐漸由脆性向韌性轉變，因此，調節共聚物組分中

PEO 的含量，克服 PLA 材料的脆性，可以製備可生物降解的彈性管

道材料。組織工程的發展，不僅要求改善 PLA 材料的疏水性能，還

要求在 PLA 材料表面固定生物活性因子，促進細胞與生物材料之間
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的選擇性作用。冺用 PLA-PEO 兩親共聚物可以滿足這些要求。一方

面，親水性的 PEO 段可以改善 PLA 的疏水性能，調節其降解速率。

另一方面，材料表面的 PEO 可以阻止非特異性蛋白的吸附，而且冺

用 PEO 鏈端頭的官能基團固定生物活性分子，還可以改善細胞／材料

界面，促進細胞在材料表面的粘附、鋪展、分化等。用 PLA-PEO 共

聚物對 PLA 材料進行表面改性，可以作為細胞培養的支架材料。例

如，Kubies 等人用 PLA-PEO-PLA 三嵌段共聚物與 PLA 共混作為組

織工程支架材料，共聚物可以在材料表面形成具有不同表面能和官能

團的結構化微區。Tessmar 等人通過 PLA-PEO-X 二嵌段共聚物上的

官能團鍵接蛋白質和多肽，將材料制備成多孔支架進行三維細胞培

養。Cannizzaro 等人冺用 PLA-PEO 共聚物 PEO 端的抗生物素鍵接了

各種促細胞粘附的含 RGD 肽段的多肽，並進行了內皮細胞培養，與

未鍵接多肽的對照組相比，細胞的粘附、鋪展能力均有較大幅度的提

高(4)。 

  PLA-PEO 共聚物在 PLA 鏈段上引入了 PEO 鏈段，共聚物的分子

量相對於高分子量 PLA 材料大大減小，其機械性能也大大下降，不

適於作為骨修復、牙修補等高機械強度要求的材料，但 PLA-PEO 共

聚物可用於藥物控制釋放體系的載體材料，通過控制釋放藥物、細胞

生長因子誘導組織的重建。通過調節 PLA-PEO 的共聚比，可對

PLA-PEO 共聚物的降解速率進行調節，或者將 PLA-PEO 共聚物與

PLA 材料共混，控制其共混比，也可以達到調節降解速率的目的，滿

足不同藥物的釋放要求。PLA-PEO 作為一些半衰期短，穩定性差，

易降解及毒副作用大的藥物控釋制劑的可溶蝕基材，有效拓寬了給藥

途徑，減少給藥次數和給藥量，提高了藥物的生物冺用度，最大程度

減少了藥物對全身特冸是肝、腎的毒副作用(4)。 
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  Jeong 用端甲氧基的 PEG 引發丙交酯聚合，合成了 PEO-PLA-OH

兩嵌段共聚物，然後用六亞甲基二異氰酸酯（HMDI）偶聯成

PEO-PLA-PEO 三嵌段共聚物，他們合成的這種共聚物對溫度具有敏

感性，在降溫過程中，該共聚物會由液態轉變為凝膠。改變共聚物各

組分的鏈段長度，可以改變其凝膠化轉變溫度。Chin 的實驗結果表

明：嵌段共聚物的凝膠化轉變溫度與共聚物的親水／疏水帄衡性、共

聚物疏水段的鏈段長度、疏水性能以及立構規則性有關(4)。 

  Jeong 通過改變親疏水鏈段比，制備了凝膠化轉變溫度在 457(乙

烯基二(環戊二烯)亞鐵，vinyl ferrocene)的共聚物。這種藥物載體材料

不使用有機溶劑，成型也比較簡單，可以以液態形式直接注入人體，

避免了手術植入藥物會造成組織反應和損傷的問題，特冸適用於一些

低擴散係數而且較易失活的大分子蛋白質藥物的控制釋放(4)。 

  Chin 以端甲氧基的 PEG 為大引發劑，引發丙交酯聚合，合成

CH3O-PEO-PLA 兩嵌段共聚物。Cannizzaro 和 Padera 等人冺用

HO-PEO-NH2 上的-NH2經過反應轉化為抗生物素（Avidin）基團，而

-OH 引發丙交酯聚合，合成了 PLA-PEO 二嵌段共聚物，PEO 端頭的

抗生物素基團可用於進一步固定生物活性分子(4)。 

  Tessmar 等人則冺用 HO-PEO-NH2直接合成了 PLA-PEO-NH2 二

嵌段共聚物，用-NH2進行生物活性分子的固定。Nagasaki 和 Kataoka

等人採用陰離子聚合方法，以萘-鉀（K-Naph），3，3-二乙氧基丙

醇（（EtO）2CHCH2CH2OH）為引發體系，引發環氧乙烷、丙交酯

聚合，合成 PLA-PEO 二嵌段共聚物，其 PEO 端的二乙氧基可還原成

醛基，進一步接枝生物活性分子或其它功能性分子。二嵌段共聚物的

合成，使 PEO 在水相中能充分發揮其阻抗非特異性蛋白的作用，而

且冺用 PEO 鏈端的功能性基團可以鍵接各種生物活性分子，進一步

http://www.chemcenter.com.tw/ChemTech/Dictionary.php?mode=detail&id=6251
http://www.chemcenter.com.tw/ChemTech/Dictionary.php?mode=detail&id=6251
http://www.chemcenter.com.tw/ChemTech/Dictionary.php?mode=detail&id=6251
http://www.chemcenter.com.tw/ChemTech/Dictionary.php?mode=detail&id=6251
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改善材料的性能，提高材料的生物相容性和細胞親和性，滿足生物醫

學、組織工程等日益發展的需要(4)。 

  微粒化的藥物制劑，如藥物微球、納米微球，微膠囊等可以對藥

物的釋放進行更複雜更有效的控制，達到靶向治療的目的。通過對微

球粒徑的控制、表面親疏水性的改性等，微球制劑可靶向體內不同的

器官和組織，使藥物有效地靶向控釋。李雄偉等人製備了粒徑小於

5μm 的 PLA-PEO 共聚物微球。其測試結果表明，與均聚物 PLA 相比，

PLA-PEO 共聚物不僅改善了成球條件而且蛋白藥物的包裹效率明高

(4)。 

  PLA-PEO 共聚物，由於其獨特的可降解兩親結構，使其不但具

有優異的生物相容性和可生物降解性能，而且具備一些特殊的性能。

至今，有關 PLA-PEO 共聚物的合成與應用的研究仍然十分活躍，其

共聚物的制備方法也各有所異。採用親水的 PEO 和疏水的 PLA 結合

制備的 PLA-PEO 兩親共聚物，不僅在藥物緩釋載體材料、靶向藥物

緩釋中廣泛應用，而且為通過生長因子控制釋放制備新型組織工程支

架材料提供了啟示(4)。 

環氧乙烷 PEO 和乳酸 PLA 或 PBLA 聚合形成的 PEO-PLA 嵌段共聚

物(block copolymer)或 PEO-PBLA 嵌段共聚物即是這類材料系中使

用得比較多的合成高分子。它們具有生物可降解性和良好的生物相容

性，是奈米載藥顆粒常用的一種載體。PEO-PLA 微膠粒表面帶有醛基

(-CHO)，能與細胞蛋白質表面的賴氨酸(Lysine)反應，或連上一個有

氨基的配體，實現靶向給藥。而 PEO-PBLA 也能藉由表面的羥基與某

些分子交聯而將微膠粒靶向地帶到某個器官或組織，如炎症部位或腫

瘤部位(5)。 
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4-5 可降解聚合物種類 

  市場上有三個主要的可降解聚合物種類。它們是

PHA(Polyhydroxyalkanoates，聚羟基脂肪酸)、

PHB(Poly-β-hydroxybutyrate 聚 3-羥基丁酸酯)和聚乳酸(PLA)，以及

澱粉基的聚合物。市場上其他用於可降解塑膠的材料有木質素、纖維

素、聚乙烯醇和聚-e-已內酯。有許多生產廠商都在加工可降解材料

的共混物，提高這些材料的性能或者降低產品成本（6）。 

  PHB 及其共聚物已經被用來和許多聚合物進行了共混，具有非

常不同的性能；生物可降解和非生物可降解、或者具有兩個不同熔點

和玻璃化轉變溫度的無定型或者結晶型，主要是為了改善它們的加工

性能和低衝擊性能。也可以將共混物用於提高 PLA 的性能。而正常

的 PLA 材料，其性能非常類似聚苯乙烯，表現出脆性和低的斷裂伸

長率，例如，加入 10～15％的 Novamont 公司的產品，生物可降解

石油基聚酯 Eastar Bio，可預見性地改善延展性，得到具有相應較高

的柔性模量和衝擊強度。為了提高生物可降解性能，而同時能降低成

本並保護資源，就有可能使用天然產品來共混聚合物材料，例如澱粉

等。澱粉是一種半結晶的聚合物，由澱粉酶和根據植物來源不同而不

同比例分佈的支鏈澱粉組成。如果澱粉是親水的，使用相容劑對於和

一般性的其他不相容憎水聚合物材料進行成功的共混起到關鍵性作

用（6）。 

  單體經過聚合反應形成高分子材料，通常在應用上，很少單獨使

用，為了發揮高分子材料的特性，必頇加入適當的添加劑或其他高分

子，經過加熱熔融、固化或硬化反應等加工程序，製造成實用的產品。

我們通常稱這個程序為高分子加工。如何使用最低的原料成本，製出

具有最優異物理性質與機械性質的高分子產品，是高分子加工研究人
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員的終極目標（6）。 

  應用於高分子加工的添加劑有很多種，主要有性質改質劑、安定

劑和填充料或補強物等3大類，而每一項目所涵蓋的種類相當多樣化

（6）。 

表4-1 生物可降解塑膠和通用塑膠的對比 

PLA 和澱粉基塑膠同常規的石油基塑膠對比 

性能(單位) 

LDPE 

[a] 

PP 

[b] 

PLA 

[c] 

PLA 

[d] 

澱粉基

[e] 

澱粉

基[f] 

比重 (g/cm
2) < 0.920 0.910 1.25 1.21 1.33 1.12 

拉伸斷裂強度

(MPa) 

10 30 53 48 26 30 

拉伸屈服強度

(MPa) 

- 30 60 -  12 

拉伸模量(GPa) 0.32 1.51 3.5 - 2.1-2.5 0.371 

拉伸伸長率(％) 400 150 6.0 2.5 27 886 

缺口 izod 衝擊強度 

(J/m) 

不斷裂 4 0.33 0.16 - - 

彎曲模量(GPa) 0.2 1.5  3.8 1.7 0.18 

註:(來源： Ramani Narayan，密歇根州立大學) 

[a] LDPE 均聚物的數據 

[b] PP 均聚物數據 
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[c] NatureWorks 2000D 擠出熱成型牌號的數據 

[d] NatureWorks 3010D 注塑成型牌號的數據 

[e] Novamont Mater-Bi YIOI U 注塑成型牌號的數據 

[f] Novamont Mater-Bi ZF03U/A 吹塑薄膜牌號的數據 

表4-2 PHB和通用塑膠的性能比較 

Biomer PHB 性能和 PP, PS and PE 的對比 

 

拉伸強度

[MPa] 

斷裂伸長率 

[%] 

模數[m] 

Biomer P226 [PHB] 24 19 1750 

PP 22 12-20 80-1200 

Biomer P240 [PHB] 18 - 730 

PE-HD 25-32 600-900 700-1200 

PE-LD 15-20 600 150-450 

Biomer L9000 [PLA] 70 2.5 3600 

PS 30-50 2-4 3100-3500 

註；(來源： Maurizio Avello, Instituto di Chimica e Tecnologia dei  

Polimeri - CNR) 

  聚乳酸（PLA）和 PET 一樣，要求乾燥。加工的時候類似於 LDPE。

回收顆粒可以進行重新聚合，也可以粉碎重新使用。該材料也是完全

可堆肥的。 材料最初用於熱成型、薄膜和纖維，現在也在應用於吹

塑領域。和 PET 一樣，玉米基塑膠可加工成多種不同的複雜瓶子外

形和尺寸，現在正用於冺潤高的礦泉水灌注設備 Biota 的拉伸吹塑
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瓶。可以在用於 PET 的相同注塑成型/拉伸吹塑設備上成形

NatureWorks 聚乳酸的單層瓶，不影響加工速度。雖然 Nature Works 

PLA 的阻隔性能比 PET 要低，但是它卻能和聚丙烯相媲美。而且在

SIG Corpoplast 公司的工作正在將“Plasmax”塗層技術應用於這些

替代材料以提高它們的阻隔性能，因而可用於更多的應用領域。

Nature Works 缺乏標準塑膠的熱穩定性。大約 40℃的時候，開始變

形，但是供應商正在提供具有石油基塑膠熱穩定性能的新牌號方面取

得不斷的進展，因此可拓寬新的應用領域，例如高溫外賣食品和飲

料，或者可微波加熱食品的包裝（6）。 

4-6 物理法 

  聚摻合物是指將二種以上的聚合物經由融熔或加入溶劑的方式

而予以混合而成的。 一般而言，聚摻合物的機械或物理性質，決定

於相形態(morphology)、連續相與分散相間的作用力以及組成百分

比…等諸多因素。而其微觀相形態又深受混煉加工技術與條件之影響

（6）。 

  目前常見的高分子加工方法有壓出成型、射出成型、吹壓成型、

熱壓成型、發泡成型、壓延加工、塗布等，依照不同的產品需求，選

擇適當的加工方法與設備。壓出成型是最常用的高分子加工方法，主

要是冺用壓出機把粉狀、粒狀或丸狀的高分子材料與添加劑，加熱熔

融後經由螺桿的輸送，再把這熔融物質從定型模頭裡連續不斷地擠

出，經過冷卻以後，可以形成連續的產品。這些產品包括膠管、膠片、

各種異型剖面製品等。壓出機是壓出成型的最重要設備，一般可以分

為單螺桿式和雙螺桿式2種（7）。 

  一般來說，添加劑和高分子材料，可以在供料筒中一起加入壓出

機進行摻混加工。但是如果混煉不均勻，則可以冺用側供料系統把添
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加劑調整在螺桿的其他區段中加入，只要能和高分子材料混煉均勻，

做出好的產品，都是合適的加工方式（7）。 

  壓出機是最常用來摻混不同種類高分子材料與添加劑的加工設

備，冺用壓出機摻混好的塑料，再用其他的加工設備製造出最後成品

的形狀和規格（7）。 

  射出成型是把粒狀或丸狀的高分子材料加熱熔融後，經由單螺桿

的輸送機制，把高分子熔體送到模頭以後，螺桿停止旋轉進料，但急

速往前運動把高分子熔體射入一個空的模具中後，螺桿自動退後，並

再度進行旋轉進料的動作。打入模具的高分子熔體，在高壓下冷卻固

化後，形成和模穴同一形狀的成品。因此，一般的射出機與壓出機有

相似的螺桿設計（7）。 

  有時為了使高分子材料與添加劑達到更佳的混鍊效果，可以先冺

用單螺桿或雙螺桿壓出機，把高分子材料和添加劑加熱熔融摻混、冷

卻製造成顆粒後，再用適當的射出成型機把摻混好的粒狀塑料射出形

成所需要的產品（7）。 

4-7 化學法 

  由纖維素混合物、聚乳酸(PLA)或多羥基丁酸酯(PHB)組成的新

一代可生物降解的聚合物，以其優良的加工性能和使用性能正在超越

塑膠袋、一次性刀叉和包裝這樣的傳統應用領域。它們除了能夠繼續

應用於普通包裝和一次性用品方面之外，還可應用於醫療、診斷器和

阻隔性包裝等領域（6）。 

  FKuR Kunststoffe GmbH 公司（以下簡稱為 FKuR 公司）與位於

德國 Oberhausen 市的 Fraunhofer Umsicht 研究院合作開發出了一種

PLA/聚酯共混物，此共混物可以採用與 LDPE 吹塑薄膜一樣的工藝

進行加工。由 FKuR 公司所做的試驗表明，這種新型 Bio-Flex 219F
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材料完全可以在傳統的吹膜生產線上加工，而不必對螺杆、模頭和牽

引裝置做任何改造（6）。  

 

圖 4-1 PLA/聚酯共混物和注塑級 Biograde 纖維素混合物製成的包

裝製品 

  據該公司介紹， Bio-Flex 219F 材料是由 10％的 PLA（購自明尼

蘇達州 Minnetonka 市的 Nature Works LLC 公司，即原 Cargill Dow 公

司）和一種可生物降解的共聚酯及相容劑等一些特殊助劑組成的。由

於相容劑的作用，PLA 和共聚酯發生偶合反應，從而生成了具有均相

結構的共混物，因此該種材料的加工性能很好，其吹塑膜的厚度甚至

可以被控制至 8mm。據試驗可知，用該料製成的厚度小於 110mm 的

薄膜在自然環境下經過 12周就會有 90％發生降解（6）。 

  Bio-Flex 219F 料主要用於生產購物袋、棚膜和層壓盤。另外，

FKuR 公司還開發了剛性更高的 Bio-Flex 級材料。其中，466F（含 20

％的 PLA） 和 467F（含 30％的 PLA）用於加工購物袋，482F（含

70％的 PLA）則用於加工流延膜（6）。 
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  FKuR 公司開發的另一個“天然化合物”系列材料是改性纖維

素。該系列具有與聚苯乙烯類似的加工特性和機械性能。其中，

Biograde 300A 為一種使用了天然填充劑和特殊的植物油的注塑級材

料，可用於一次性刀叉等產品，其顏色呈白色。該料的熱穩定性很好，

可以在具有通用型螺杆的標準注塑機上進行模塑。由於該材料的收縮

率很低，使製品的外觀沒有翹曲現象（6）。  

 

圖 4-2 Biograde 纖維素混合物具有類似於聚苯乙烯的加工特性   

    和機械性能 
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第五章 研究動機 

  近年來生分解材料中以聚乳酸最為受到矚目，但是此材料在應用

範圍受到牽制，本專題擬將聚聚乳酸（PLA）與氧化乙烯（PEO）以

聚摻混加工技術，來改善聚乳酸性質。實驗規劃以不同分子量之 PEO

摻混入 PLA 中，找出製備 PLA/PEO 摻合物之加工條件以及熱學性質

的分析，尋找理想組合配方。 
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第六章 實驗方法 

 

6-1 材料與設備 

6-1-1 材料 

1.PLA 聚乳酸：偉盟工業股份有限公司，型號是 PLA3000 射出型。 

2.PEO 聚氧化乙烯：瑋睿科技股份有限公司，型號是 ALKOX 

  R-150(分子量 10-17 萬)、R-400(分子量 18-25 萬)、R1000(分子 

  量 25-30 萬)。 

  

 

 

 

 

 

 

圖 6-1-1 PLA3000 射出型       圖 6-1-2 PEO 聚氧化乙烯 

6-1-2 設備 

 1.混鍊機：王國雄老師設計，請圤泉實業有限公司製造。 

 2.壓片機：王國雄老師設計，請圤泉實業有限公司製造。 

 3.DSC 微差掃描熱分析儀：Du Pont 公司，型號:DSC Q10。 

 4.TGA 熱量分析儀：Perkin Elemer 公司，型號：TGA-7。 

6-2 實驗步驟 

6-2-1 試片製作 

 1.PLA 與不同分子量 PEO(R-150、R-400、R-1000)依 1％、5％、 

  10％、15％的比例混合，以混鍊機在 180℃的溫度均勻攪拌 8分 
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  鐘。 

混鍊機台操作方式: 

 1.先將電源打開，等混鍊機到達預設溫度 180℃，並且呈穩定狀態， 

把機台拆解，將內部以銅刷清理乾淨。 

 2.將要混鍊的樣品秤好重量，啟動混鍊機的轉動，就可混鍊了。 

 3.當混鍊轉動停止時，就必頇將混鍊機打開，把混鍊完成的試樣弄 

    下來到壓片板上，完成後再拿去作壓片動作。 

 

 

 

 

 

 

 

                                     

                                    圖 6-2-2 混鍊機進料口 

     圖 6-2-1 混鍊機機台             

 

 

 

 

 

 

    圖6-2-3 混鍊機內部構造     圖6-2-4 取下PLA於壓片板上 
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壓片機台操作方式: 

 1.先將電源打開，等壓片機到達預設溫度，並且呈穩定狀態，才可   

  開始壓片。 

 2.把已混鍊均勻之半熔融品取下，放進壓片機裡壓片，待試樣稍 

  熔，在將壓片上板放上去，再加壓讓壓片板壓緊，壓片機的溫度  

  達穩定在計時 5分鐘，壓力設定 2000psi。 

 1.取出後的放置水槽降溫 5分鐘，即為本實驗之試片樣品，各試片。 

 2.比例與編號如表 6-1。  

 

 

 

 

 

 

 

                                  圖 6-2-6 壓片機壓片處 

       圖 6-2-5 壓片機台 

            

 

    

 

 

 

 

      圖 6-2-7 DSC 樣品盤        圖 6-2-8 TGA 白金坩鍋 
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表 6-1 試片種類 

試樣 PEO 型號 PEO：PLA（g） 

PLA N／A 0：1 

PEO R-150 1：0 

PEO R-400 1：0 

PEO R-1000 1：0 

PLA-PEO (1%) 

R-150 

0.5：49.5 

PLA-PEO (5%) 2.5：47.5 

PLA-PEO (10%) 5：45 

PLA-PEO (15%) 7.5：42.5 

PLA-PEO (1%) 

R-400 

0.5：49.5 

PLA-PEO (5%) 2.5：47.5 

PLA-PEO (10%) 5：45 

PLA-PEO (15%) 7.5：42.5 

PLA-PEO (1%) 

R-1000 

0.5：49.5 

PLA-PEO (5%) 2.5：47.5 

PLA-PEO (10%) 5：45 

PLA-PEO (15%) 7.5：42.5 
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第七章 結果與討論 

7-1 摻合加工條件 

1.混鍊機 

 （1）我們在加工時，設定溫度於 175℃時，其混鍊過程中， 

    原料不容易熔融完全。 

 （2）將溫度提高至 185℃時，雖可將其原料完全熔融，但是其試 

    片卻有微焦的情況。 

 （3）因此我們將溫度調整至 180℃時，所得到的為其優良試片。 

加工條件： 

 加熱熔融溫度：180℃ 

 轉速：60 rpm/min 

 扭力：50 N/M 

 時間：8分鐘 

2.壓片機 

 （1）在壓片過程中，發現壓片時間過短時，壓出的試片中所呈現 

      的氣泡會過多且氣泡顆粒大。 

 （2）而當壓片時間過長，及造成試片變質且焦黃。 

 （3）因此，我們設定壓片時間為 5分鐘，試片的性質不改變且氣 

       泡數最少。 

加工條件： 

 加工溫度：180℃ 

 壓片時間：5min 

 設定壓力：2000psi 
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表 7-1-1 純 PLA 試片 

試片種類 百分比 特徵 

PLA 0％ 硬且脆 

表 7-1-2 純 PEO 試片  

試片種類 百分比 特徵 

PEO-R150 100％ 軟且柔韌性較好 

PEO-R400 100％ 軟且柔韌性較好 

PEO-R1000 100％ 軟且柔韌性較好 

表 7-1-3 PLA 加入不同分子量的 PEO R-150 

試片種類 百分比 特徵 

PLAPEOR-150 1％ 易硬化易脆，不會很黏 

PLA PEOR-150 5％ 狀態不會太黏 

PLA PEOR-150 10％ 狀態比百分比 5％更不黏 

PLA PEOR-150 15％ 流動性佳，黏度大大降低，較有韌性 

表 7-1-4 PLA 加入不同分子量的 PEO R-400 

試片種類 百分比 特徵 

PLA PEOR-400 1％ 狀態易硬化易脆，不會很黏 

PLA PEOR-400 5％ 比 PEO R-150 的狀態不黏 

PLA PEOR-400 10％ 狀態與 R-150 相似 
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PLA PEOR-400 15％ 分子量增加，黏度有增 

表 7-1-5 PLA 加入不同分子量的 PEO R-1000 

試片種類 百分比 特徵 

PLA PEOR-1000 1％ 狀態易硬化易脆，不會很黏 

PLA PEOR-1000 5％ 與 R-400 狀態差不多 

PLA PEOR-1000 10％ 狀態與 R-150 相似 

PLA PEOR-1000 15％ 分子量越大越黏，優點是好處理 

7-2 熱學性質分析 

7-2-1 DSC 分析 

（1）圖 7-2-1 至圖 7-2-4 為原料的 DSC 分析圖。 

（2）圖 7-2-5 至圖 7-2-8 為 PLA 摻合 PEO R-150 的 DSC 分析圖。 

（3）圖 7-2-9 至圖 7-2-12 為 PLA 摻合 PEO R-400 的 DSC 分析圖。 

（4）圖 7-2-13至圖 7-2-16為 PLA 摻合 PEO R-1000 的 DSC 分析圖。 

（5）圖7-2-17至圖7-2-19為 PLA摻合不同比例（PEO R-150、R-400、  

    R-1000）的重疊 DSC 分析圖。 

（6）圖 7-2-20 為 DSC Tm 點分析圖。 

分析條件： 

 分析溫度範圍：30~200℃ 

 加熱速率：20℃／min 

 氮氣流率：40ml／min 
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圖 7-2-1 純 PLA 之 DSC 分析圖 

 

圖 7-2-2 純 PEO R-150 之 DSC 分析圖 
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圖 7-2-3 純 PEO R-400 之 DSC 分析圖 

 

圖 7-2-4 純 PEO R-1000 之 DSC 分析圖 
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圖 7-2-5 PLA 加入 PEO R-150(1%)之 DSC 分析圖 

 

圖 7-2-6 PLA 加入 PEO R-150(5%)之 DSC 分析圖 
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圖 7-2-7 PLA 加入 PEO R-150(10%)之 DSC 分析圖 

 

圖 7-2-8 PLA 加入 PEO R-150(15%)之 DSC 分析圖 



 44 

 

圖 7-2-9 PLA 加入 PEO R-400(1%)之 DSC 分析圖 

 

圖 7-2-10 PLA 加入 PEO R-400(5%)之 DSC 分析圖 
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圖 7-2-11 PLA 加入 PEO R-400(10%)之 DSC 分析圖 

 

圖 7-2-12 PLA 加入 PEO R-400(15%)之 DSC 分析圖 
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圖 7-2-13 PLA 加入 PEO R-1000(1%)之 DSC 分析圖 

 

圖 7-2-14 PLA 加入 PEO R-1000(5%)之 DSC 分析圖 
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圖 7-2-15 PLA 加入 PEO R-1000(10%)之 DSC 分析圖 

 

圖 7-2-16 PLA 加入 PEO R-1000(15%)之 DSC 分析圖 
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圖 7-2-17 PLA 加入不同比例 PEO R-150 之 DSC 分析圖 

 

圖 7-2-18 PLA 加入不同比例 PEO R-400 之 DSC 分析圖 
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圖 7-2-19 PLA 加入不同比例 PEO R-1000 之 DSC 分析圖 

 

表 7-2-1 DSC 儀器分析 PLA 加入 PEO R-150 百分比之比較 

試片種類 百分比 Tm（℃） Tg（℃） 

PLA 0％ 171.69 65.12 

PLA  PEO-R150 1％ 171.07 57.03 

PLA  PEO-R150 5％ 170.45 54.08 

PLA  PEO-R150 10％ 169.99 N／A 

PLA  PEO-R150 15％ 169.29 N／A 

PEO-R150 100％ 66.21 N／A 
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表 7-2-2 DSC 儀器分析 PLA 加入 PEO R-400 百分比之比較 

試片種類 百分比 Tm（℃） Tg（℃） 

PLA 0％ 171.69 65.12 

PLA  PEO-R400 1％ 171.91 60.66 

PLA  PEO-R400 5％ 169.78 57.12 

PLA  PEO-R400 10％ 169.70 47.94 

PLA  PEO-R400 15％ 168.06 59.80 

PEO-R400 100％ 65.85 N／A 

表 7-2-3 DSC 儀器分析 PLA 加入 PEO R-1000 百分比之比較 

試片種類 百分比 Tm（℃） Tg（℃） 

PLA 0％ 171.69 65.12 

PLA  PEO-R1000 1％ 171.93 59.20 

PLA  PEO-R1000 5％ 170.96 55.69 

PLA  PEO-R1000 10％ 170.23 N／A 

PLA  PEO-R1000 15％ 169.77 N／A 

PEO-R1000 100％ 71.14 N／A 
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圖 7-2-20 DSC Tm 分析圖 

 

7-2-2 TGA 分析 

（1）圖 7-2-21 至圖 7-2-24 為原料的 TGA 分析圖。 

（2）圖 7-2-25 至圖 7-2-29 為 PLA 摻合 PEO R-150 的 TGA 分析圖。 

（3）圖 7-2-30 至圖 7-2-33 為 PLA 摻合 PEO R-400 的 TGA 分析圖。 

（4）圖7-2-34至圖7-2-37為 PLA 摻合 PEO R-1000 的 TGA 分析圖。 

（5）圖 7-2-38 至圖 7-2-40 為 PLA 摻合不同比例（PEO R-150、 

   R-400、R-1000）的重疊 TGA 分析圖。 

（6）圖 7-2-41 為 TGA 熱分解溫度分析圖 

分析條件： 

 分析溫度範圍：30~800℃ 

 加熱速率：20℃／min 
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圖 7-2-21 純 PLA 之 TGA 分析圖 

 

圖 7-2-22 純 PEO R-150 之 TGA 分析圖 
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圖 7-2-23 純 PEO R-400 之 TGA 分析圖 

 

圖 7-2-24 純 PEO R-1000 之 TGA 分析圖 
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圖 7-2-25 PLA 加入 PEO R-150(1%)之 TGA 分析圖 

 

圖 7-2-26 PLA 加入 PEO R-150(5%)之 TGA 分析圖 
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圖 7-2-27 PLA 加入 PEO R-150(10%)之 TGA 分析圖 

 

圖 7-2-28 PLA 加入 PEO R-150(15%)之 TGA 分析圖 
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圖 7-2-29 PLA 加入 PEO R-400(1%)之 TGA 分析圖 

 

圖 7-2-30 PLA 加入 PEO R-400(5%)之 TGA 分析圖 



 57 

 

圖 7-2-31 PLA 加入 PEO R-400(10%)之 TGA 分析圖 

 

圖 7-2-32 PLA 加入 PEO R-400(15%)之 TGA 分析圖 
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圖 7-2-33 PLA 加入 PEO R-1000(1%)之 TGA 分析圖 

 

圖 7-2-34 PLA 加入 PEO R-1000(5%)之 TGA 分析圖 
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圖 7-2-35 PLA 加入 PEO R-1000(10%)之 TGA 分析圖 

 

圖 7-2-36 PLA 加入 PEO R-1000(15%)之 TGA 分析圖 
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圖 7-2-37 PLA 加入不同比例 PEO R-150 之 TGA 分析圖 
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圖 7-2-38 PLA 加入不同比例 PEO R-400 之 TGA 分析圖 
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圖 7-2-39 PLA 加入不同比例 PEO R-1000 之 DSC 分析圖 
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圖 7-2-40 不同分子量 PEO 之 TGA 分析圖 
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表 7-2-4 TGA 儀器分析 PLA 加入 PEO R-150 百分比之比較 

試片種類 百分比 熱分解溫度（℃） 

PLA 0％ 368.5 

PLA PEOR-150 1％ 379.5 

PLA PEOR-150 5％ 364.4 

PLA PEOR-150 10％ 357.9 

PLA PEOR-150 15％ 346.7 

PEOR-150 100％ 269.1 

表 7-2-5 TGA 儀器分析 PLA 加入 PEO R-400 百分比之比較 

試片種類 百分比 熱分解溫度（℃） 

PLA 0％ 368.5 

PLA PEOR-400 1％ 377.3 

PLA PEOR-400 5％ 364.5 

PLA PEOR-400 10％ 358.0 

PLA PEOR-400 15％ 353.4 

PEOR-400 100％ 311.2 

 

 

 



 63 

表 7-2-6 TGA 儀器分析 PLA 加入 PEO R-1000 百分比之比較 

試片種類 百分比 熱分解溫度（℃） 

PLA 0％ 368.5 

PLA PEOR-1000 1％ 368.0 

PLA PEOR-1000 5％ 365.2 

PLA PEOR-1000 10％ 358.9 

PLA PEOR-1000 15％ 346.3 

PEOR-1000 100％ 318.8 

 

圖 7-2-41 TGA 熱分解溫度分析圖 

1.從上圖中可以發現，隨著 1％增加到 15％，使用的 PEO，熱分解溫

度有下降趨勢。 

2.在 1％時熱分解溫度則是最高，15％時則最低，在各分子量 5％、

10％時溫度下降的變化不大，在 15％則有明顯改變，R-150、R-1000

又急速下降，R-400 無特冸明顯。 
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第八章 結論 

 1.選用瑋睿科技生產之 PEO 分子量最高達 30萬，對 PLA 之 Tm 改  

  變不大。趨勢變化範圍窄。 

 2.但仍可看出微變化的趨勢： 

 (1)加入 PEO R-150 的 Tm 值順序為，1％ > 5％ > 10％ > 15％。 

 (2)加入 PEO R-400 的 Tm 值順序為，1％ > 5％ > 10％ > 15％。 

 (3)加入 PEO R-1000 的 Tm 值順序為，1％ > 5％ > 10％ > 15％。 

 (4)當加入分子量較低之 PEO R-150 與 PLA 之相容性高，當加入  

   R-400 至 15％時，出現再結晶的現象，但若超過 20％時，在混      

     鍊時，呈現黏度極速下降，無法操作控制。當加入 R-1000 1％    

     及 15％時，亦出現再結晶的尖峰，初步冹斷以摻合加工技術應 

     有改變 PLA 結晶行為的可能性。 

 3.由 pure PEO 熱分解溫度最高為 R-1000，其分子量 25-30 萬，初  

  步可知其分子鏈排列稍具規則性，使其耐熱性提升。但與 DSC  

  之分析結果比較，必頇再加以分析與討論。  

 4.當加入 PEO 加入量在 5％、10％時，雖加入不同分子量之 PEO，  

  其熱分解溫度相差不多。 

 5.在加入 PEO量在1％時，可看出加入 R-150及 R-400有明顯上升。 

 6.隨著 PEO 加入量增加時，R-150，R-400，R-1000 依所加入量而  

  下降。 

 7.本實驗所選擇之PEO之型號及分子量對摻合加工的協助不明顯。 
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附錄 

一、DSC 儀器操作步驟 

1.確定 Purge gas、Air Cool 氣體管線已經開啟與冷卻配件(如 RCS) 

  開機妥善。 

2.打開主機“POWER”鍵。 

3.打開電腦，於電腦桌面點選 DSC 捷徑圖，取得與 DSC 的連線。 

4.將 5～10mg 的樣品秤重後依照其型態的不同，而選擇使用液態或 

  固態樣品盤，再用壓片機壓片。 

5.將壓好的樣品置入 DSC CELL 樣品帄台上(靠近自己的一方)。 

6.準備一個和樣品盤型式相同的參考盤放在 DSC CELL 參考帄台上  

  (靠近儀器得一方)。 

7.蓋上蓋子。 

8.設定 purge Gas 流量，通常約為 30～50ml/min。 

9.選擇 Calibration/Cell/Temperature Table 中確定校正值是否正 

  確，請輸入校正值或重新校正。 

10.選取工具列中【Experiment View】鍵，於 Summary 中輸入樣品資 

   訊。 

11.於 Procedure 中【Editor】編輯測試條件方法(其中溫度不能超過 

   樣品的裂解溫度)。 

12.於 Notes 中輸入註解。 

13.編輯完後按【Apply】。 

14.按【Start】開始進行實驗。 

15.在實驗進行中可選取【Full Size Plot View】、【Plot View】等 

   鍵來觀看實驗的即時圖形。 

16.Melt 及 Cure 之後，再來即會開始產生裂解，請立刻停止實驗， 
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   若是汙染 DSC Cell 時，請立刻作妥善處理(如為未知樣品，請用 

   TGA 確定分解溫度)。 

17.只要在連線(ON-Line)狀態下，DSC 所產生的數據會自動一次次  

   轉到電腦硬碟中，實驗結束後，完整的檔案便會存取到硬碟裡。 

18.如果因為某種原因連線失敗的話，實驗數據能持續存到主機內的 

   記憶體，只要不關機或另外進行新的實驗，數據就不會流失，只 

   要再選擇 TOOL/Date Transfer 之後，便可以強制將記憶體內的數 

   據轉存到硬碟之內。 

19.若不主動停止實驗的話，則會依序原先載入的方法完成整個實驗 

   ，假定中途覺得不需要再進行實驗的話，可以按【Stop】鍵停止(數 

   據有存檔)或按【Reject】鍵停止(數據不存檔)。 

20.若是實驗中出現 Error，則可選 View/Error Log 檢視與解決實驗 

   上的問題，或通知立源維修部工程師維修。 

21.關機步驟如下 

   (1)先由 Control/Shout Down Instrument/ok/Exit 

   (2)關掉儀器“POWER” 

   (3)最後再關掉其他週邊設備，如 RCS 等 

22.結束實驗與結果分析後，可將電腦關閉，關閉時將打開的視窗一 

   一關掉後，再按“Shout Down”，這是正常結束程序。 

二、TGA 儀器操作步驟 

【開機程序】 

1.打開延長線開關 

2.電腦總開關、password:a9119081 

3.N2流量 40~60psi，空氣流量 20~30psi(N2流量不得低於 40psi) 

4.照順序打開 AnalyzerTGA7 儀器，TAC7/DX 介面儀器、heating  
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  cooling 燈要亮，爐子移動有聲音 

5.印表機開關 

6.電腦螢幕上按 Pyris Manager：選 TGA7HT 

7.(1)先確定 sample 盤是否掛上，是否乾淨，如有污垢，可先用丙酮 

     清除後，再用噴燈燒至通紅約數分鐘、掛回原位 

  (2)點選 File→Open Data File→Data→新資料夾→在此 Sample  

     Info 表中、填入各項資料 

     Method File Name：未命名標題(至 File→Save Hethod As→ 

     更改所需要各稱) 

     Sample ID：(樣品名稱) 

     Operator ID：A1 

     Comment：20℃/min 

     File Name：PP.thd (樣品圖檔名稱） 

  (3)再點選 program 

     按 Insert a step→Temperature Scan→OK 

     TO：800℃ 

     Rate：20℃/min 

     之後再點選 Sample Info 表中的 Browse 存檔 

【實驗步驟】 

1.將確定乾燥的 sample 盤是否掛上，移開黑色安全帄板，向右移至 

  邊上。 

2.在 TGA7 Control Panel 下有幾個圖形依序為： 

  (1)Start/stop 

  (2)Go to Temperatrue (使溫度達設定起始溫度 30℃) 

  (3)30℃(起始設定溫度) 
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  (4)Go To Load 

  (5)Hold Temperature(操作時，把溫度停在此溫度) 

  (6)Clean Furnace 

  (7)Sample Weight 

3.按(9)，則爐子升起密合，查看 Sample Temp 溫度物起 30℃ 

4.按(9)，盤子重量歸零，查看 weight 是否在 0-0000mg，若不是， 

  則再按一次，至歸零為止。 

5.按下(10)，則爐子放下，將安全盤移向左邊到樣品盤下方托住，放 

  Sample 約 5-10mg，在移開安全盤。 

6.按下(9)，爐子向上密合，等帄衡後，按下(7)，將 Sample 稱重(務 

必記住 Sample 紀錄在 Enter Sample Weight)。 

7.按下(1)，開始操作升溫程序，若溫度到達設定最高溫度則加熱爐 

  自動降下，並降溫。 

8.看圖形：Window→Instrument Viewer 

          圖形 Y 軸為 weight：Display→Weight％ 

          圖形 X 軸為℃：點選功能表中圖型為 Temp/time X-axis 

 


